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1 Introduction 
These Training Notes provide a reference during and following Civica Education’s VET Advanced 
training.  They cover all of the main sections of the VET module.  The VET Manual provides a 
comprehensive guide to the software. 
 
During training we will be working with fictitious data and all the exercises contained within this 
user guide refer to that data.  
 
The training is designed to review the original VET module training and to allow users the 
opportunity to explore functionality and features of the VET module in a bit more depth. 
 

1.1 VET Advanced Training Program 

Time Contents 

8.45 am Coffee 

9.00 am Welcome 
Housekeeping 
Introductions 

9.10 am Logging On 

Tool Bars And Side Bars 

Introduction to Administration Manager 

 Staff Details 

The VET Module 

 Terminology and Concepts 

 Control 

  System Preferences 

 VET Parameters  

 VET Utilities  

10.30 am Morning Tea 

10.50 am  Delivery Planning 

 Student Profiling 

  Adding VET students 

  VET Student Groups 

  VET Enrolments 

  VET Student details – Miscellaneous 

  VET Results  

12.30 pm Lunch 

1.10 pm 

 

 Mail Merge 

 Reporting to the School Curriculum and Standards Authority 

Administration Manager 

 Creating an Ad Hoc Reports 

2.40 pm Afternoon Tea 

3.00 pm School as RTO/Review  
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1.2 Training Outcomes 

The aim of this course is to review the outcomes addressed in the original VET Training Program 
with particular emphasis on the following:  
 

 Add, edit and delete VET parameters 

 Import Qualification and Competency Data 

 Create and use Competency Groups 

 Add enrolling VET Students 

 Create and use VET Student Groups 

 Enrolment of students in  Qualifications and Competencies 

 Enter Students’ VET results in bulk 

 Enter and maintain General and AVETMISS data through VET student details - Miscellaneous 

 Create and use VET Reports using mail merge 

 Create export files for the School Curriculum and Standards Authority 

 Create an Ad Hoc Report 
 
 

1.3 Logging On 

Activity 
 

 Double click on the Integris icon on your desktop 

 Type ADMIN into the User Name field 

 Press the <Tab> key 

 Type KEYS into the Password field 
 

 
 

 Click on Login, or press <Enter> 
 

 

Note: In schools, each user has their own user name and password, which enables access 
to particular sections of the software as determined by the school administration. 

It is strongly recommended that you change your password regularly. 
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1.4 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 

 Password enables the user to change his or her password.  
For security purposes, it is recommended that this is done 
regularly. 

 Change User should be used to ensure that each person 
accessing Integris does so under their own user name and with 
their personal levels of access. 

 Lock Terminal may be used if the user needs to leave his or 
her computer temporarily, does not want to log off and does 
not want to allow access to anyone else.  Unlocking the 
terminal requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send 
any report created in Integris.  The options are displayed 
below. 

 
 

 
 
  



 
Integris_VET_Advanced_Training_Notes.docx 13-Feb-13 

Page 10 of 130 

© 2013 Civica Education Pty Ltd 
 

 

Activity 

Top Toolbar > File 

 View each of the following items in the File menu 
o Password 
o Change User 
o Lock Terminal 
o Report Destination 

 

 
 

1.5 Help Contents and Index 

Activity 

Help > Help Contents and Index 

 
 

 Select Integris VET Help 

 Click Help 
 
The VET Manual will be displayed. 
 

 Scroll down to view the Table of Contents 

 Close the Help window 
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2 Administration Manager 
Administration Manager comprising of the General and Admin modules is the basis of the Integris 
software.  Users of the VET module will need to be aware of particular functions within the 
Administration Manager to be able to work effectively in the VET module.  
 
The functions or sections that VET co-ordinators should be familiar with are: 
 

 School Details 

 Student Details  

 Staff Details 

 Groups 

 Parameters 
 

2.1 Staff Details 

 General > Staff Details 

Administration Manager can hold details on staff.  The staffing section of the system is 
accessed via the Staff Details icon on the General side bar.  
 

Activity 

General > Staff Details > Add  

Add yourself as a member of staff. Enter the following data, tabbing between the fields. 
 

 Title 

 Initials 

 Surname * 

 First Name * 

 Date of Birth (DDMMYYYY) * 

 ID Number * 

 Gender 

 Staff Code (first 3 letters of your surname + first initial) * 
 
* Indicates the field is a mandatory field. 

To add your WACOT number: 

 Select the UDI  tab  

 Highlight WACOT Number  

 Click Edit pencil   

 Enter a WACOT number * 

 Click OK 
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3 The VET Module 
The VET module allows users to import essential VET information such as qualifications and units 
of competency, and to identify which qualifications and/or units of competency they wish to offer in 
a given calendar year.  VET students can then be identified and enrolled into appropriate 
qualifications and competencies.  Recording of VET results may be done individually by student or 
in bulk by simultaneously entering results for all students undertaking a selected competency. 
 
The VET module also stores information on employers who are able to take students for work 
placement, and maintains a history of every student placement for a given employer.  Similarly, a 
record of each student’s work placement history is also kept.   
 
A comprehensive set of VET reports will aid the VET coordinator in his or her day-to-day duties, 
and enable the transfer of VET data from schools to the School Curriculum and Standards 
Authority who are responsible for collecting VET data which meets the AVETMISS (Australian 
Vocational and Training Management Information Statistical Standard) requirements. 
 

3.1 VET Terminology and Concepts 

Vocational Education has undergone major changes in the past 10 years, and is continuing to 
evolve rapidly.  While certain aspects of VET are controlled nationally by organisations such as 
DEEWR (Department of Education, Employment and Workplace Relations) according to 
AVETMISS (Australian Vocational Education and Training Management Information Statistical 
Standard), each state will implement VET in secondary schools in slightly different ways, and the 
terminology used by each state will vary.  It is therefore important that the terminology used in the 
VET module is clearly understood by all users.   
 
 A Unit of Competency is a unit of study undertaken as part of the study requirements for a 
qualification.  Competencies can be grouped together to complete the requirements for a 
qualification.  
 
A Qualification is the packaging of units of competency that will lead to accreditation – usually a 
certificate.  A qualification, as referred to in the VET module, is sometimes referred to as a course 
by some states and reporting bodies.  The Western Australian enrolments data standard, for 
example, will refer to a certificate as a qualification, but the code that describes it as a course code. 
 
An RTO is a Registered Training Organisation.  AVETMISS requires all RTOs to report their 
activity on a regular basis.  The VET module is fully AVETMISS compliant in that it will store all the 
required data and report as per AVETMISS requirements.  Accordingly, each RTO will be 
associated with one or more locations.   
 
School as RTO is a secondary school that is an RTO.  The VET module has a specific window 
where the school registers as an RTO.  Having done this, the school will have access to all 
certification requirements.   
 
VET students are a sub-set of the school’s students identified by the user.  They must be enrolled 
in at least one unit of competency and may also undertake Workplace Learning and/or other VET 
endorsed programs.  There is a specific function in the VET Module to identify VET students from 
within the general school population.   
 
An Enrolment is the association of a VET student with a qualification or a unit of competency.  A 
student can have many qualification enrolments and many competency enrolments at the same 
time.  In Western Australia, each competency enrolment must be linked to a qualification 
enrolment. 
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Trade Training Centres are schools which have been given additional funding to provide facilities 
that allow students to complete higher level qualifications predominately in the trade areas. 
 

3.2 Using the VET Sidebar 

 

 

Students enables users to identify VET students, enrol students in 
qualifications and units of competency, enter student’s results, view students’ 
work placement history and view details of units of competency such as mode 
of delivery, the designated Registered Training Organisation (RTO) and the 
result. 
 

Delivery Planning is where the qualification and competency offerings are 
identified for the selected calendar year, RTOs are defined, and enrolments 
monitored. 
 

Employers enables users to list active and inactive employers, add or edit 
employer details, view all students placed with a particular employer, and place 
students with employers.  
 

Placement allows users to browse through their lists of students and 
employers and allocate work placements accordingly.  It is possible to locate a 
group of students or employers using the appropriate find tools.   
 

Reports allows users to produce a wide range of reports for internal use and 
export files for the Curriculum Council.   
 

Parameters is where items appearing in menus elsewhere in the VET module 
may be viewed and, in a few instances only, added, edited, deleted and made 
active or inactive according to the needs of the school. 
 

Utilities enables users to import AVETMISS data and codes, industry codes, 
and qualification and competency data, and to process the Active status of VET 
students. 
 

Control allows the Systems Administrator to change some of the default 
system preferences for all those using the VET module.  The system 
preferences may be tailored to suit a range of a school’s requirements.  
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3.3 VET Checklist  

Some VET functions will only need to be set up once in the system.  Other VET functions will need 
to be set up annually. 
Below is a useful checklist for VET coordinators which outline the tasks which will need to be set 
up only once in the system, followed by the tasks which will need to be set up annually.  Those 
items marked with an asterisk are essential.   

Setting Up Tasks 

 VET>Control: Enter System Preferences * 
 

 VET>Parameters: Edit user defined parameters as required   
 

 VET>Utilities: Import ANZSCO, FOE and Industry Codes, * 
 

 VET>Delivery Planning: Register the school as a Training Provider and/or set up external RTOs 
* 

 

Annual Tasks  

 VET>Utilities: Import Qualifications, Competencies and the links between them * 
 

 VET>Delivery Planning: Identify the School VET Offerings – qualifications, competencies and 
competency groups - for the current year. * 

 

 VET>Students: Add enrolling VET and work experience students * 
 

 VET>Students: Create VET student groups 
 

 VET>Students: Speed edit students’ vocations 
 

 VET>Students>Student Details or Bulk Enrolment: Enrol students in qualifications and/or units 
of competency * 

 

 VET>Students>Student Details>Miscellaneous: Enter General and AVETMISS information for 
all enrolling VET students * 

 

 VET>Employers: Enter employer details * 
 

 VET>Placements or VET>Employers>Student Placements or VET>Students> Student 
Details>Placement Details: Enter work placement details * 

 

 VET>Students>Student Details> Placement Details: Edit students placement attendance details 
 

 VET>Reports>Curriculum Council Reports> VET Enrolments: send VET enrolments to the 
School Curriculum and Standards Authority* 

 

 VET>Students: Enter enrolling VET students’ results, dates of completion and, where applicable, 
certificate numbers *  

 

 Print Qualification Certificates and Statements of Attainment and Achievement (RTO schools 
only) 

 

 VET>Reports>Curriculum Council Reports >VET UoC Results, VET Qualification Achieved  
 

 
For the purpose of today’s training we will assume that some of the above functions have already 
been done so the focus will be on ongoing maintenance of student enrolments, employer details, 
student placements, further allocation and resulting of enrolments and some reporting. 
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3.4 Control  

VET > Control 

Clicking the Control sidebar icon will open the menu window with just one option - 
System Preferences.  This function will allow the System Administrator to change the default 
system preferences for all those using the VET module.   
 

 
 
Double clicking System Preferences will open the VET Preferences window. 
 

 

Note:  At school the Enrolment Cut-Off Dates will be the dates that enrolments are due to 
the School Curriculum and Standards Authority and the Import Directory will be 
K:\KEYS\INTEGRIS\VET IMPORTS\.  In 2013 the cut-off date for Year 12 enrolments is the 21 
June and, for other years, 16 August, 
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Display VET students with an Inactive status 

In VET > Students, the student list will display by default only those students with a VET status of 
Active.  If Display VET students with an Inactive status is checked then Inactive VET students 
will also be visible.  It is recommended that this option is not checked. 
 

Auto enrol students in competencies linked to a qualification 

The VET module stores the link between a qualification and its competencies, and this data can be 
imported using the VET qualification and competency import functions.  Thus, when a student is 
enrolled in a qualification, it is possible to auto enrol the student in all of the linked competencies 
for that qualification.  Checking this option enables this functionality.  It is recommended that this 
option is not checked and that competency groups are used instead. 
 
This option has no effect when bulk enrolling multiple students. 
 

Check Module/UOC exists for the selected qualification during enrolment 

Checking this option will prevent users from continuing with a competency enrolment when the 
competency is not linked to the qualification(s) the student is enrolled in.  It is recommended that 
this option is checked. 
 

Enrolment cut-off date active 

The Enrolment cut-off date active checkbox will prevent existing enrolments from being deleted, 
the RTO code changed or their integrated status being changed after the enrolment cut-off date.   
This feature is enabled by DoE and is only managed if the user is logged in via the DoE account. 
This date will be changed for each calendar year.   
 

Allow concurrent enrolment in a competency at different RTOs 

A student will normally undertake study in a competency at just one RTO, and the system will 
prevent you from enrolling a student in the same competency across two different RTOs.  
However, there might be cases where a student is legitimately studying at two RTOs for the same 
competency.  Enabling this function will allow concurrent enrolment in a competency at different 
RTOs. 

Note: This is NOT enabled for Department of Education (WA) schools. 

The default is to have this option switched off, thereby preventing the inadvertent double enrolment 
of a student across two RTOs. 
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Auto offer all linked competencies for a qualification 

Setting up qualification and competency offerings is normally a two-stage process.  First set up all 
the qualification offerings and then set up all the competency offerings. However, if competencies 
are linked to a qualification, it is possible to automatically offer all competencies linked to that 
qualification at the time you offer the qualification. 
 
The value specified in the system preferences is a default only.  There is the option within the 
School VET Offerings window to override the system preference setting.  The window option will 
initially take on the value of the option in the System Preferences. However, it can be switched on 
and off in the offerings window without changing the value in the system preferences.  It is 
recommended that this option is checked. 

Open Student/Employer windows in detail mode rather than list 

Clicking the Student or Employer button on the sidebar will open the Student and Employer list 
window by default.  A specific student or employer’s details can then be viewed by double clicking 
on a record in the list.  Enabling the Open Student/Employer windows in detail mode rather than 
list will bypass the list window and open the details window instead.  It is recommended that this 
option is not checked. 
 
It should be noted that this option affects all users.  It cannot be set on a user-by-user basis. 
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Activity 

VET > Control 

 Click on Control on the VET sidebar  

 Double click on System Preferences 
 

 
 

 Set the VET preferences for training as displayed below 
 

 

Note:  At school the Enrolment Cut-Off Dates will be the dates that enrolments are due to 
the School Curriculum and Standards Authority and the Import Directory will be 
K:\KEYS\INTEGRIS\VET IMPORTS\.  In 2013 the cut-off date for Year 12 enrolments is the 21 
June and, for other years, 16 August, 

 Click OK to save 

 Close Control 
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3.5 VET Parameters 

VET > Parameters 

Information relating to reference data such as Industry areas, ANZSCO codes, Employment 
Categories etc. can be maintained from within Parameters.  Click on the Parameters icon in the 
VET sidebar to see the list of parameters.  
 

 
 
 
There are three types of VET parameters: 

1. Pre-populated parameters: These are parameters that are automatically loaded into the 
system when it is first installed.  They typically include parameters that will be the same across 
all schools (e.g. the range of AVETMISS reporting parameters). 

2. Imported parameters: These parameters are empty when the system is first installed, but 
there are facilities to import them into the system.  They include parameters that will need to be 
updated on a regular basis such as qualifications and competencies.  

3. User-definable parameters: These parameters are not pre-populated, and there is no facility 
to import them.  They are the parameters that will vary from school to school. 

 

Note: Only User-definable parameters can be added to, edited or deleted. 
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3.5.1 Pre-populated Parameters  

VET > Parameters 

Some parameters have been pre-populated with data, ready for use in schools.  These are 
required for AVETMISS reporting, and conform to the AVETMISS 6.1 standard (July 2011).  For 
Department of Education (WA) schools, data will be collected from all schools with VET in 
Schools students. 

 

Pre-populated Parameters include 

 AVETMISS – Commencing Course Identifier: Identifies whether the client is enrolling for the 
first time in a Training Package qualification or course within the training organisation. 

 AVETMISS - Delivery Type: Identifies the type or mode of delivery for a unit of competency or 
module enrolment. 

 AVETMISS - Disability Type: Identifies the type(s) of disability, impairment or long-term 
condition that a client indicates on the enrolment form.  

 AVETMISS - Funding Source – National: Identifies the source of the funding for the delivery 
of a unit of competency or module enrolment. 

 AVETMISS - Funding Source – State Training Authority: Identifies the internal funding 
source used to fund delivery of a unit of competency or module enrolment. 

 AVETMISS - Highest School Level Completed: Identifies the highest level of school that a 
client has completed.  

 AVETMISS – Labour Force Status: Describes a client’s employment status. 

 AVETMISS - Outcome Assessment: Identifies the result or outcome of a client’s enrolment in 
a unit of competency or module.   

 AVETMISS - Prior Educational Achievement: Identifies the type of prior educational 
achievement successfully completed by a client. 

 AVETMISS - Proficiency in Spoken English: Is used to assess the English-speaking ability 
of people who speak a language other than English.  

 AVETMISS - Qualification Category: Identifies the category of the recognised qualification 
awarded to an individual on successful completion of a qualification or course.  

 AVETMISS - RTO Type: Identifies the type of training organisation. 

 AVETMISS - Recognition Status: Distinguishes a qualification or course by its level of 
recognition within the VET sector. 

 AVETMISS - State: Identifies the State or Territory of the physical location of a training 
organisation.   

 AVETMISS – Study Reason Identifier: Identifies the client’s main reason for study. 
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 Delivery Type Site:  Identifies what type of organisation is delivering the VET course 
 

 
 

 Trade Training Centre Name:  Identifies the name of the Trade Training Centre.  This is a 
mandatory field once the Trade Training Centre is selected from the Delivery Site Type 
menu. 
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 Trade Training Centre Site:  Identifies the Site that is linked to the Trade Training Centre 
Name 

 

 

Delivery Type Site, Trade Training Centre Name and Trade Training Centre Site are new 
parameters that are different from RTO Arrangement. 

 

 RTO Arrangement: Linked to the funding source of the student enrolment. Types of 
arrangements are displayed below. 
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Note:  Network Schools Arrangement refers to schools that share resources to deliver 
qualifications at a host school site. 

 

 Student Traineeship:  distinguishes between School Based Traineeship, Aboriginal 
School Based Traineeship, School Based Apprenticeship and Pre-Apprenticeship in 
Schools. 

 

 Vocation/Job Type: is a description of the type of work a student may be interested in.  
Examples include Retail Assistant, Automotive Mechanic, Child Care and Office Duties.  Each 
employer can be linked to multiple job types representing the type of jobs available at that 
employer for work placement.  Students can be assigned up to two preferred job types, and the 
system will then try to match employers with certain job types to students with those preferred 
job types. 

 

3.5.2 Imported Parameters 

These parameters contain high volumes of data that may change from time to time.  The VET 
module import routines allow this data to be maintained by periodically importing the data into the 
VET module.  The user selects the appropriate import function from the Utility sidebar option and 
then selects the appropriate comma delimited file for import. 
 
The parameters that can be imported are 

 AVETMISS - ANZSCO (Australian and New Zealand Standard Classification of 
Occupations): Identifies the type of occupation that may be expected for those undertaking a 
program of study.  This information is used to profile VET delivery at state and national levels.   

 AVETMISS - Field of Education:  Identifies the education category for a unit of competency or 
module.  

 Industry Codes: The standard industry codes. 

 Qualifications: The full set of qualifications available to the system.  The school will create a 
subset of this parameter list as the qualification offerings for any given year. 

 Competencies: All competencies available to the system.  Schools will create a subset of 
competencies on offer in any one year. 

 Links between Qualifications and Competencies: The VET module allows the user to link 
Qualifications and Competencies to ensure that students are only enrolled in recognised 
competencies for a qualification.   

Note: None of the above parameters can be added to, edited or deleted.  

 

3.5.3 Qualification and Competency Parameters  

The Qualifications and Competencies parameter windows are the only non-standard parameter 
windows used in the VET module.  Below is a detailed description of the Qualifications parameter 
window.  The Competencies window operates in exactly the same manner although the fields 
contained within the window are different. 
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Qualifications 

VET > Parameters > Qualifications 

 
 

Qualifications Toolbar 

 Go to the VET offerings window. 

 Print the selected Qualification records. 

 Print All the Qualification records. 
 
The information shown within this window represents: 
 

 Qualification Code 

 Qualification Description 

 Supervised Hours 

 Vet Flag (Yes or No) 

 Expiry Date 

 ANZSCO Code 

 Qualification Category Identifier 

 Field Of Education Identifier 

 Recognition Status 

 Industry Area 
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VET Offerings 

The Qualification parameter window has an additional button  in the toolbar that takes the 
user to the VET Offerings window.  This window enables the user to define the VET offerings 
(qualifications, competencies and competency groups) for a calendar year. 
 

Printing Qualifications Parameters 

Users have the options to print all or some of the qualifications.  

To print all the qualifications: 

 Click on Print All  

 Click Yes 

 Select a report destination 

 Click OK 

 Enter a report header or leave the default header in the Report Header window 
 

 
 

 Click OK 
 

To print selected qualifications: 

 Highlight the qualifications to be printed (use <Ctrl> to select individual records, and/or drag 
the cursor down a list of records to select them) 

 Click Print Selected  

 Select a report destination 

 Click OK 

 Enter a report header or leave the default header in the Report Header window 

 Click OK 
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Competencies 

VET > Parameters > Competencies 

 
 
The Competencies parameter window operates in the same manner as the Qualifications 
window.   
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3.5.4 Editing User-definable Parameters 

Activity  

VET > Parameters > Employer Correspondence Type 

 Click Modify/Add Parameters  

 Enter the Employer Insurance Letter as shown below 
 

 
 

 Click OK  

 Highlight Employer Insurance Letter and click Toggle Locked Status  

 Click Close 
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VET > Parameters > Student Correspondence Type 

 Add and lock Parent Insurance Letter 
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3.6 VET Utilities 

3.6.1 Downloading the School Curriculum and Standards Authority VET 
Import files  

The School Curriculum and Standards Authority import files are imported into the VET module 
through Utilities.  These import files are available from the School Curriculum and Standards 
Authority at  
http://www.curriculum.wa.edu.au/internet/Senior_Secondary/Vocational_Education_and_Training/
VETInfo_All_Schools/    

To download the School Curriculum and Standards Authority import files 

 Right click on the csv file you wish to import and select Save Target As … 
 

  
 

 Navigate to the folder where you wish to save the file – K\keys\Integris\VET Imports is 
recommended  

 

 Click Save 
 

 
 

 Click Yes 

 Repeat for each file you need to download 

 Go to VET > Utilities to import the new files 
 

http://www.curriculum.wa.edu.au/internet/Senior_Secondary/Vocational_Education_and_Training/VETInfo_All_Schools/
http://www.curriculum.wa.edu.au/internet/Senior_Secondary/Vocational_Education_and_Training/VETInfo_All_Schools/
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IMPORTANT  
Importing AVETMISS ANZSCO, Field of Education and Industry Codes 
is only carried out for the initial setup or if otherwise advised by VET in 

schools. 

 

3.6.2 Importing Qualification and Competency Data 

VET > Utilities > Import Qualification and Competency Data  

Selecting Import Qualification and Competency Data will give the user the option to import 
qualification and competency information together with the links between qualifications and 
competencies.  Qualifications, competencies and their links can be imported at the same time, or 
individually.  However, importing the link data without all the appropriate qualification and 
competency data will result in a large number of errors written to the error log. 
 

 
 
If the user clicks Cancel, the import is aborted and the user returned to the qualification and 
competency import window.  If the user selects Import, he or she will be given the option to 
choose the appropriate folder and the Select button begins the import.   
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Note:  At school the default pathway will be K:\keys\Integris\VET Imports.  Users may 
choose to navigate to another location if required. 

 
The processing order is qualifications, then competencies, and then the links between them.  
When the import starts, the following progress bar will appear: 
 

 
 
Once the data has been imported, VET – Qualification and Competency Import window will need to 
be closed.  

Note: Qualification, Competency and Links files are updated regularly.  School will need to 
check the School Curriculum and Standards Authority website to ensure that they have the 
latest import files. 
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Activity 

VET > Utilities 

Importing Qualification and Competency Data 

 Double click on Import Qualifications and Competency Data 

 Ensure that each tick box has been selected and click Import 
 

 
 

 Navigate to C\keys\Integris\VET Imports 

Note:  At school the pathway would be K\keys\Integris\VET Imports 

 
 

 Click Select 
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3.7 Delivery Planning 

VET > Delivery Planning 

Delivery planning is the process whereby the qualification and competency offerings are defined 
for the selected calendar year, Registered Training Organisations (RTOs) are defined and 
enrolments monitored. 
 
Clicking the Delivery Planning icon on the sidebar will open the delivery planning options window: 
 

 
 

3.7.1 Set up External RTOs 

VET > Delivery Planning > Set up External RTOs 

The VET module has the facility to store information about external training organisations that 
deliver training on behalf of the school, or audit the school’s training in an auspice arrangement.  
An external training organisation can be an independent body or another school.  The external 
training organisation data is used to link a student competency enrolment with a training 
organisation.  This is a mandatory national reporting requirement.   
 

 
 
To open the Set-up External RTOs window, double click on Set-up External RTOs in VET – 
Delivery Planning. 
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Adding a new RTO 

To add a new RTO, click the Add  in the toolbar.  This will enable data entry to the fields in 
Registered Training Organisation Details and grey out the Location list. 
 

 
 
The user may enter the data in this window and then click the OK or Cancel. 
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Activity 

VET > Delivery Planning > Set-up External RTOs 

 Click Add  

 Enter the information shown below, use <Tab> to move between fields 
 

 
 

 Click OK and Close 
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3.7.2 School VET Offerings  

VET > Delivery Planning > School VET Offerings 

Each school will only offer a small subset of all qualifications and competencies available through 
VET.  Every year schools will select those qualifications and competencies they will be offering.  
Students can only be enrolled in those qualifications and competencies on offer in a particular 
calendar year. 
 
The School VET Offerings window in Delivery Planning provides the facility to select the 
qualifications and competencies on offer for a specific calendar year.  
 

School VET Offerings Toolbar 

 
 

 
The current calendar year 

 
Edit: Allows the user to edit the Offerings window 

 
Qualifications: A list of qualifications and qualification offerings 

 Competencies: A list of competencies and competency offerings 

 
Competency Groups: Create Competency Groups 

 
Print Selected: Prints the selected items to a standard report 

 
Print All: Prints all the records in the list to a standard report 

 

Qualification Offerings 

VET > Delivery Planning > School VET Offerings > Qualifications 

 
 
The window will default to the current calendar year and will display two lists – Qualifications NOT 
offered, and Qualifications ON offer.  The latter list will initially be empty, and the former will 
contain all the qualifications that appear in the Qualifications parameter window. 
 

 To place a qualification on offer, the user clicks the edit pencil in the top toolbar and then 
selects a qualification or qualifications in the left hand pane and clicks the Move Right button.  The 
qualification/s will be removed from the Qualifications NOT offered list and will appear in the 
Qualifications ON Offer list.   
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 The qualification can be moved back to the Qualifications NOT Offered list by selecting it 
and clicking the Move Left button.  
 

 The Filter List button assists users to locate qualifications by code or by name.  
 

 
 

Competency Offerings 

VET > Delivery Planning > School VET Offerings > Competencies 

Clicking the Competencies button  in the toolbar will switch to the Competencies view.  The 
operation of this view is identical to that for the qualifications view.  All the columns in every list can 
be resized at will, and the user has the ability to scroll left and right across the list to see additional 
fields. 
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Activity  

VET > Delivery Planning > School VET Offerings 

 Double click School VET Offerings 
 

 
 

 Click Edit    

 Ensure that there is a tick next to Auto Offer Competencies linked to Qualifications  
 

 
 

 Click Filter  

 Use the Filter to locate Information qualifications  
 

 
 

 Click Apply Filter 

 Select ICA101111 Certificate 1 in Information, Digital Media and Technology  
 

 
 

 Move to the right  

 Click OK to save 
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 Click on the Edit pencil   then the Filter button  

 Use the Filter to locate Employment qualifications  
 

 
 

 Click Apply Filter 

 Select 52402WA Certificate I in Keys to Employment 
 

 
 

 Move to the right  

 Click OK to save 
 

 Click Competencies  

 View the linked competencies on offer 
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Competency Groups 

VET > Delivery Planning > School VET Offerings > Competency Groups 

The School VET Offerings window also allows for the creation of competency groups. 
 

Switch to the Competency Groups view by selecting the Competency Groups icon.  
 
A competency group is linked to a calendar year, and can contain any number of competencies 
from the list of competencies on offer for that year.  
 
A new competency group is defined by first adding a competency group name to the competency 
group list, and then adding competencies to the newly created group.  

To add a new competency group: 

VET > Delivery Planning > School VET Offerings > Competency Groups 

 Click on Competency Groups  

 Click Add   
 

 
 

 Click Qualification Find   
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 Enter search criteria in the Qualification Find window and click Find or click on the Find button 
and all Qualifications on Offer for the year will be displayed 

 

 
 

 Highlight the Qualification required and click Select. 

 Enter a description for the group  

Note:  Matching Competency and Student Group names is recommended to streamline 
enrolments. 

 
 

 Click OK  
 

 
 

 Click Add Competencies  on the right  
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 Enter the search criteria and/or click Find  

 Highlight the required units of competency and click Select.  

Note: Only competencies linked to that qualification can be added.  
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Activity 

VET > Delivery Planning > School VET Offerings > Competency Groups 

 Click on Competency Groups  

 Click Add   
 

 
 

 Click Qualification Find   
 

 
 

 Click Find  
 

 
 

 Highlight the Certificate I in Information,  Digital Media and Technology  

 Click Select 
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 Enter a description for the group  
 

 
 

 Click OK  
 

 

 Click Add Competencies  on the right  
 

 
 

 Click Find  
 

 
 

 Highlight the first eight units of competency 

 Click Select and Yes  
 

 

 Create a Competency Group Cert I Keys to Employment and add all competencies. 
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Recap: Preparation and Planning 

Complete each of the following tasks and note the pathway you took. 

1. Enter the detail of an RTO used by your school.   
 
 
 
 
 
 

2. Add ICA20111 Certificate II in Information, Digital Media and Technology to the School 

VET Offerings for 2013.  
 
 
 
 
 
 
 

3. Create a Competency Group Cert II Information, Digital Media and Technology 
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3.8  Student Profiling   

This window enables users to: 
 

 Identify which students are VET students   

Note: There are two classes of VET students – enrolling and work experience only.  
Enrolling students can be enrolled into qualifications and competencies, and put on work 
placement.  Work experience students can be put on work placement, but cannot be 
enrolled into qualifications or competencies. 

 Enrol students in particular qualifications and units of competency 

 Bulk enrol selected students into selected competencies 

 Enter students’ results 

 Bulk enter student results 

 View work placement histories for each student 

 View details of unit of competencies such as mode of delivery, the RTO delivery arrangement, 
the locations and the results 

 
Clicking the Students icon on the sidebar will open the VET Student List window.   
 

 
 
The window will initially display all the VET students on the current roll.  VET students on the 
Former, Admissions and External rolls can be viewed by selecting the appropriate roll status from 
the dropdown list on the toolbar.  The information provided by this window includes: 
 

 Student Name 

 Year and Form 

 Whether or not the student is an active VET student  

 Whether the student is an enrolling student or a work experience student 

Note: Enrolling students can be enrolled into qualifications and units of competency, and 
put on work placements.  Work Experience students can be put on work placements, but 
cannot be enrolled into qualifications or competencies.  

 School Code – used to identify whether a student has come from another school (RTO 
arrangement)  
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Note: Students originating from the local school will have the local school code appearing 
here.  Students from other schools will have that school’s code, or the generic Other code 
to signify they have come from any other school. 

 FTE – Assigning students an FTE of zero is one way to exclude those students from appearing 
in census reports and statistics,  VET Students originating from another school should have 
their FTE set to 0 for this reason  

 No: of Competencies - represents the total number of competencies that a student is enrolled 
in 

Note: Once students have been enrolled in units of competency, they cannot be removed 
from the VET student list, even if they withdraw from the course.  The fact that they were 
once enrolled must be included in AVETMISS reporting.  In this instance their results would 
be recorded as 40 - Withdrawn or 99 – Enrolled in Error. 

 

3.8.1 VET Student Details 

The VET Student Details window is launched by clicking the Student Details button  in the VET 
Student List toolbar.  
 

 
 
Browsing and navigation in this window is similar to the standard Integris Student Details window.  
There is the standard previous, next, find and roll selection items in the toolbar.  There is also the 
standard fast find field at the bottom of the window. This permits a user to enter a student’s 
surname, or part of his or her name, or the student’s reference number and the system will find the 
matching records.  It works in exactly the same manner as the Student Search field in the main 
Integris Student window, except that it searches just the list of VET Students. 

Enrolment View 

The window will open in the Enrolment View mode as shown above.  This view displays the 
qualification and competency enrolments for the student. 
 
Clicking a qualification row in the list will display all the student competency enrolments for that 
qualification in the list below.  When a student is enrolled in a qualification the user will need to 
specify a start-date and a completion date.  Similarly, once the qualification has been completed 
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there is the facility to enter details such as if the qualification was achieved and a certificate issued 
and, if known, the certificate identifier.   
 

Activity  

VET > Student  

 View the VET Student List 

 Click on different column headings to sort 

 Double click on Sally Angus to view her details 

 Click Close 
 

Add some Year 10 students as enrolling 

 Click Add  and then Find  to find Form 10.3 
 

 
 
 

 Click Find 

 Highlight the first 10 students 
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 Click Select and Yes  

 Highlight the names and use the red chevrons  to add these students to the list of VET 
students  

 Click OK and Close 
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Add students enrolled in 1ACSC_3 as enrolling VET students 

  Click on Add/Remove VET Students  

  Click Student Find  

 Select the T Sets/Cohorts tab and enter the information as shown  
 

 
 

 Click Find  

 Click Select and Yes 

 Ensure that you have the Enrolling and This School radio buttons selected  

 Highlight the names in the Non-VET students list and click the red chevrons to move them to 
the VET students list 

 Click OK to save and Close 
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3.8.2 VET Student Groups   

 Clicking the Groups button will open the VET Student Groups window.   
 

Groups are added by clicking Add Groups , entering a Group Description and clicking OK. 
 

Activity 

VET > Students 

 Click the Groups button   

 Click Add Groups  on the left 

 Enter the Group Description 2013 Keys l 
 

 
 

 Click OK  
 

 Click Add Members  on the right 

 Find the Enrolling Year 10 students  
 

 
 

 Click Find, Select and Yes 
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 Add a second group 2013 Information I  

 Click Add Members – on the right 

 Find the students studying Computer Science 1A by entering the following search criteria  
 

 
 

 Click Go 

 Highlight the teaching set 1ACSC_3 and click Find 
 

 
 

 Click Select and Yes 
 

 

 Click Print All  

 Select Yes, you do wish to print each group on a separate page 

 Close the report and VET Student Groups 
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3.8.3 Enrolling in a Qualification 

Enrolment View 

VET > Students VET Student Details 

The window will open in the Enrolments view as shown below.  This view displays the qualification 
and competency enrolments for the student. 
 
Clicking a qualification row in the list will display all the student competency enrolments for that 
qualification in the list below.  When a student is enrolled in a qualification, the user will need to 
specify a start-date and enter a completion date once the student has actually completed the 
qualification.  Similarly, once the qualification has been completed there is the facility to enter 
details such as if the qualification was achieved and a certificate issued and, if known, the 
certificate identifier and date of issue.   
 
The Qualification list will contain a system generated entry – n/s - Not Specified for units of 
competency not linked to a qualification.  

Note: In WA all competency enrolments must be linked to a qualification.  

 
 
A student can have many qualification enrolments.  Each qualification enrolment can have a 
number of competencies associated with it, and a competency can appear in more than one 
qualification at the same time.  The system will allow the user to enter each qualification 
individually and then go onto enter each competency for each qualification individually, or enter the 
qualification with all its competencies. 
 

To enrol in a qualification, the user will click the Add button  alongside the Qualification list.  
This will open the VET Qualification Enrolment window: 
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The student name and reference number will appear in a banner across the top of the window.  
Typing the qualification code in full and pressing the tab key will trigger a search of the database 
for a qualification with a matching code.  A successful match will be indicated by the qualification 
name appearing underneath the code.  Alternatively, the user can use the Qualification 
Find button to locate the appropriate qualification.  
 

 
 
Enter the relevant search criteria and click Find. 
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The user can select the required qualification by highlighting it in the list and clicking Select or 
double clicking an entry in the list.  The selected qualification will be transferred to the VET 
Qualification Enrolment window. 
 

 

Note:  
Only enter a Qualification Completion Date after the students has achieved the 
Qualification. 
The Qualification Completion Date will only be saved when Qualification Achieved is 
checked.  Similarly, Qualification Achieved will only be saved when the Qualification Date is 
entered. 
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The user has the option of automatically enrolling the student in the linked competencies.  Leaving 
the box next to auto-enrol student in all linked competencies for the qualification empty and 
clicking OK will enrol the student in the qualification only.  Ticking auto-enrol student in all linked 
competencies for the qualification will result in the linked competencies being displayed in the 
list pane.   
 
When auto-enrolling in linked competencies for the qualification, clicking OK will result in the 
Competency Enrolment window being launched where the user must complete the delivery and 
AVETMISS information for the competencies.   
 

 
 

Delete  any units of competency not required.  Enter Start and Completion dates.  Select the 
Delivery tab and enter the RTO information.  Teacher is a mandatory field.  The VET Coordinator 
should always be the nominated as the teacher.   
 

 
 
Select the AVETMISS tab and enter the required information. 
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Note:  If the students are School-based trainees or Aboriginal School-based trainees then a 
Contract ID must be entered.  The Contract ID is the student’s Training Program Outline 
(TPO) number which is registered by the Training Records System (TRS). 

Click OK to save 
 

3.8.4 Enrolling in Units of Competency 

Please note: It is a State VET requirement that all competency enrolments be linked to a 
qualification (certificate). This applies even if a student is only enrolled in one competency. 

Ensure the required qualification is highlighted. Clicking the Add button next to the Competency list 
on the Enrolments tab of VET Student Details will open the VET Competency Enrolment 
window. 
 

 
 

The user has the option of entering a single competency code or using Find Competencies.   If 
a competency code is entered, the window will show its name and code.  If Find is clicked then the 
VET Competency Find window is launched.  Users may specify any of the search criteria, 
including Code and Name and then click Find to locate the desired unit(s) of competency. 
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Highlight the required units of competency and click Select. 
 

 
 
Enter Start and Completion dates.   
 

 
 
Select the Delivery tab and enter the RTO information.  Teacher is a mandatory field.  The VET 
Coordinator should always be the nominated as the teacher.   
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Select the AVETMISS tab and enter the required information. 
 

 

Note:  If the students are School-based trainees or Aboriginal School-based trainees then a 
Contract ID must be entered.  The Contract ID is the student’s Training Program Outline 
(TPO) number which is registered by the Training Records System (TRS). 

 Click OK to save 
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3.8.5 Bulk Qualification & Competency Enrolment 

Clicking on the Bulk Qualification & Competency Enrolment button  on the VET Student List 
toolbar will open the Bulk Qualification & Competency Enrolment window.  This window 
provides an easy mechanism for allocating multiple competencies to multiple students, rather than 
individually for each student. 
 

 
 
All actions in this window relate to a calendar year.  Selecting a new calendar year will clear the 
window and the competencies list will be refreshed to show the competency offerings and 
competency groups for the selected year.  

Students may be located using the Find button.   
 
The window works by moving students and competencies from the left hand list into the right hand 
list and clicking the Add or Remove button.  Clicking Cancel will close the window and not save 
any changes. 
 
The user can select multiple students and/or student groups and then move them across using the 
move right button.  The students then appear within the selected student’s box.  Competency 
Groups and Qualifications may be selected in the same way. 
 
Students, Competency Groups and Qualifications can be removed from their respective selected 
lists by highlighting the appropriate records and clicking the move left button.  
 
Clicking Add will add the selected Qualification or Competency Group to all the selected students.   
 
The Qualification Start Date needs to be entered.  Information such as the Competency Start 
and Completion Date, the RTO, Mode and Arrangement also need to be specified.   
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The drop-down values for RTO Arrangement are: 
 

Type Description Scenario 

Outsourced – Profile 
Hours 

Funding is provided from the ‘Skilling 
Australia’s Workforce (SAW) 
Agreement’ between the 
Commonwealth and State 
Governments. 

Funding is provided direct from the 
Department to the RTO and does not 
appear in schools gateway payments. 

Students are enrolled in a VET 
certificate and either attend a 
local RTO campus or the RTO 
provides a lecturer to come to 
the school. 

This mode covers traineeships 
and ‘PAIS-Pre Apprenticeship 
in Schools’ on top of the 
standalone VET. 

School Auspicing with 
an RTO 

Schools enter into an agreement with 
an RTO to have qualified school 
teachers deliver and assess the 
student’s vocational training. 

The partner RTO issues the printed 
Certificate and Statement of 
Attainment as required 

Students stay at school and 
undertake a VET certificate 
delivered and assessed by a 
qualified school teacher. 

School as an RTO 

This option is only 
available to those 
schools who are RTOs. 

The school applies for RTO status 
and applies for scope of various 
qualifications.  Staff at the school 
deliver and assess the vocational 
training 

VET in Schools is responsible for 
issuing printed Certificates and 
Statements of Attainment as required. 

VET in Schools provides funding in 
the school gateway to accommodate 
for some of the associated costs. 

There are currently 21 RTO 
schools in WA.  This parameter 
is only available to schools that 
have RTO status. 

All training and assessment is 
carried out by the school, 
usually on site. 

Outsourced – Fee for 
Service 

Schools enter into an agreement with 
an RTO to provide all of the training 
and assessment of a VET certificate 
at full fee paying rates.  The school 
pays the RTO directly 

VET in Schools provides funding in 
the school gateway up to a cap for 
the user choice amount. 

Students are enrolled in a VET 
certificate and either attend a 
local RTO campus or the RTO 
provides a lecturer to come to 
the school. 

Fee for Service is often utilised 
where an RTO in not able to 
provide training under profile 
due to lack of hours, and/or the 
school does not have staff that 
are able to deliver the training 
under an auspice arrangement. 

Network Schools 
Arrangement 

Schools share resources to deliver 
qualifications at a host school site. 

Students are enrolled in their 
home school but attend 
another school for their VET 
training.  The arrangement is 
flagged as Network Schools 
Arrangement to ensure that 
VET in Schools funding is 
directed to the host school and 
not the home school. 
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Linked units of competency may be deleted  and added.   
 
Once Add is clicked the following window will be displayed. 
 

 
 
Once Add is clicked and the units of competency added, a Bulk Student Competency 
Enrolment Status Log will be displayed (see below). If a student has already been enrolled in a 
competency, the software will not re-enrol them but will provide a message in this regard. 
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Activity 

VET > Student > VET Student Details 

 Open the Bulk Enrolments window  

 Highlight the student group 2013 Information I and move to the right by clicking on the red 

chevrons  

 Select the competency **Group** Cert I Info and move it the right  
 

 

Note:  Ensure that you select the **Group** and not the actual Qualification. 

 Click Add  
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 Enter the delivery details as shown below 
 

 

Note:  
1. The start and completion dates for units of competency must not be prior to the start date 
for the Qualification. 
2. The completion date for units of competency must be after the start date. 

 

 

 Click Add and enter the following AVETMISS details 
 

 
 

 Click Add   

 View the Enrolment Status log and Close 
 

 

 Highlight Ashleigh Campbell in the VET Student List 

 Click View VET Student Details  

 View Stephanie’s enrolments 
 

 Return to the VET Student List  
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VET > Students 

 Click Bulk Enrolments  

 Highlight the student group 2013 Keys l and move to right  

 Highlight the competency **Group** Cert I Keys to Employment and  move to right  
 

 
 

 Click Add 
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 Enter the following delivery details 
 

 
 

 Click Add 

 Enter the AVETMISS details as shown below including the Traineeship information 
 

 

Note: the Contract ID would need to be entered separately for each student. 

 Click Add and view Enrolment Status Log 

 Click Close 
 

 View Frank Bishop’s enrolment details 
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3.8.6 Removing Enrolments in Bulk 

Activity 

VET > Students > Bulk Enrolment 

The 2013 Keys l student group were enrolled in a unit of competency in error. 
 

 Click Bulk Enrolment  

 Click Switch to Removal Mode  
 

 
 

 Highlight the 2013 Keys l student group and move to the right  

 Click Find Competency  

 Select the Competency group Cert l Keys to Employment 
 

 
 

 Click Find 
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 Select the first unit of competency in the list 

 Move the competency to the right  

 Click Remove and Yes 

 View Frank Bishop’s enrolment details 
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3.8.7 Editing Enrolments 

Activity  

VET > Student > VET Competency Enrolment Speed Edit 

Two of the competencies in Certificate I in Info are being delivered by Polytechnic West while the 
rest are being delivered by SMYL.  Student records have to be edited to reflect this. 
 

 Click Competency Speed Edit  

 Find  the Competency Group Cert I Info 
 

 
 

 Click Find 

 Highlight the first two competencies in the list and click Select 
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 Click Edit  

 Highlight the first unit of competency in the list and select all of the students by highlighting 
them 

 

 Enter the RTO  
 

 
 

 Click Apply  and OK twice 
 

 Repeat for the second unit of competency 

 Close 
 

 Double click on Ashleigh Campbell and view her enrolment details 
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Activity  

VET > Student > VET Competency Enrolment Speed Edit 

The School-Based Trainees need their Training Contract IDs entered. 
 

 Click Competency Speed Edit  

 Click View Competency Enrolment by Student  

 Find  the Student Group 2013 Keys l 
 

 
 

 Click Select and Yes 
 

 Click Edit  
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 Highlight the first student in the list and all of the units of competency 
 

 
 

 Enter a Training Contract ID number 
 

 
 

 Click Apply  and OK twice 
 

 Repeat for another student in the list. 
 

 

Note:  Each student will have their individual Training Contract ID. 
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3.8.8 Re-enrolling Students in Units of Competency 

If students have been enrolled in units of competency in a previous year but did not achieve them, 
it is possible to re-enrol them in those units in the next year.  This may be done individually or in 
bulk. 
 

Activity 

VET > Students 

 Locate Sally Angus’s  records and view her results from last year 
 
She did not achieve Apply basic communication skills and would like to re-enrol in this 
competency. 
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 Click Add  to the right of the Competencies pane 

 Click Find Competencies on Offer  

 Enter BSB in the Code field and Apply in the Name field 
 

 
 

 Click Find 
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 Select BSBCMM101A Apply basic communication skills 

 Enter Start and Completion Dates 
 

 
 

 Click the Delivery tab 

 Ensure the Delivery details are correct 
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 Click on the AVETMISS tab 

 Enter the Study Reason 
 

 
 

 Click OK 
 

 
 

 Click Yes 

 Return to the VET student list  
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VET > Students 

 Click Bulk Enrolments  

 Select Joel Black and Patrick Brown and move  them to the pane on the right 
 

 
 

 Select **Group** Cert I Business and move  it to the pane on the right 
 

 Click Add 
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 Delete  all but BSBCMM101A from the list of Selected competencies 
 

 
 

 Enter the following RTO information 
 

 

Note:  The start date for the qualification is in the previous year but the start date for the 
competency must be in the current year. 

 Click Add 

 Enter a Study Reason and click Add 
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 Read the prompts and click Yes 
 

 
 

 Close 

 View Patrick Brown’s enrolment 
 

 
 

3.8.9 VET Student Details – Miscellaneous 

Miscellaneous Student Details are accessed by clicking the Miscellaneous  button in the VET 
Student Details window.  The Miscellaneous window contains three tabs: General, AVETMISS 
and Correspondence. 
 

 

Completion of the first two tabs is mandatory for ALL students and schools in Western 
Australia. 
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Miscellaneous - General 

 
 
This tab is used to record: 

 If a student is at educational risk 

 Whether or not a student is studying for a full certificate 

 Students’ preferred vocations 

 Students’ safety certificates 

 (Where applicable) Traineeship information 
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Miscellaneous – AVETMISS 

 

Note: All fields on this tab are mandatory for State and Commonwealth reporting and must 
be completed, with the exception of Mobile Phone Number, Disability and Prior Educational 
Achievement which should also be completed whenever applicable. 

 

Miscellaneous – Correspondence 

 

 
 
Users may choose to record any correspondence sent to students on this tab.   
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To add a record: 

 Click the Add button  

 Enter the relevant details and click OK  
 

 
 

To edit a record: 

 Highlight the record you wish to edit 

 Click Edit  

 Make the desired changes and click OK 
 

To delete a record: 

 Highlight the record you wish to delete 

 Click Delete  

 Confirm the deletion by clicking Yes  
 

 
 

To print a student’s correspondence log: 

 Click Print  

 Select the desired report destination 
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Activity 

VET > Students 

 Use the VET Student Search to navigate Frank Bishop’s details  

 Click Vet Miscellaneous Details  

 Click Edit  and enter the following on the General tab  
 

 

Note:  The employer in VET- Student Details>Miscellaneous>General refers to School-based 
Traineeships.  Agreement # refers to the number of the agreement regarding the 
Traineeship. 
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Entering AVETMISS Information 

 Click on the AVETMISS tab 

 Click Edit  

 Enter the following details 
 

 
 

Note: Proficiency in spoken English is only active if Language spoken at home in main 
Student Details is other than English 
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Entering Correspondence information 

 Click on the Correspondence tab 

 Click Add  

 Enter the correspondence details (leaving the date as TODAY) 
 

 
 

 Click OK twice  

 Close VET Student Details 
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3.9 VET Student Results Entry 

3.9.1 VET Individual Student Results Entry 

Results for individual students may be entered in the VET Student Details window. 
 

 
 

Entering results for a unit of competency 

Highlight the competency for which you wish to enter a result and click the Edit pencil to the right of 
the Competency pane.  This window will then open. 
 

 
 
Results are available from a dropdown menu, as is the teacher’s name.   
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Note: The teacher entered must be the school’s VET Co-ordinator and he or she must have 
a valid WACOT number. 

The options within the results dropdown list are AVETMISS.  The values within this list comply with 
the AVETMISS 6 standard, these being: 
 
20 Competency achieved/pass 
30 Competency not achieved/fail 
40 Withdrawn 
51 Recognition of prior learning – granted 
52 Recognition of prior learning – not granted 
60 Credit Transfer 
70 Continuing enrolment 

Note: Continuing enrolment is training activity in a unit of competency that continues, for a 
student, into a subsequent collection period and the student has not completed all their 
assessment criteria by the end of the current collection period. 

90 Not yet available 

Note: Code 90 may not be used as a final outcome assessment. 

99 Has not and is not expected to start this UoC  

Note: Code 99 has been added at the state level to remove incorrect enrolments from state 
and national reporting.  Only use this code when the enrolment was added in error and 
cannot be deleted as it has been reported to the Curriculum Council. 
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Note: Please consult Section 4.3 of the 2013 WACE Procedures File for additional 
information related to resulting.  The File is available on the School Curriculum and 

Standards Authority website http://www.curriculum.wa.edu.au under WACE Procedures 
File. 

 
Select the appropriate result and teacher and click OK to save. 
 

Entering results for a qualification 

A qualification may be given a completion date and a certificate number. 
 
Highlight the qualification you wish to edit and click the Edit pencil to the right of the Qualification 
pane.  The following window will be displayed. 
 

 
 

http://www.curriculum.wa.edu.au/
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The Certificate Identifier (number), Certificate Issued and Date Issued fields become available 
once Qualification Achieved has been checked.  Enter a Completion Date and the Certificate 
Identifier (if you have it) and click OK to save. 

Note:  
Qualification Achieved should only be checked after the student has completed the 
Qualification in accordance with the Training Package requirements.   

The record will not be saved unless both the Completion Date has been entered and 
Qualification Achieved has been checked. 

The Certificate Identifier is available from the RTO.  If the school is the RTO, then the 
Certificate Identifier will be generated automatically when the certificate is printed. 

 
 

3.9.2 VET Bulk Student Results Entry 

 
 
The VET Competency Enrolment Speed Edit window allows for results against a competency to 
be entered for multiple students simultaneously. 
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All actions in this window relate to a calendar year.  Selecting a new calendar year will clear the 
window and the Competencies list will be refreshed to show the competency offerings and 
competency groups for the selected year.  The Students lists will be cleared. 
 

The Competency Find Tool  can be used to select a subset of competency offerings for the 
year. 
 
Clicking on a competency in the list will display the students enrolled in that competency for the 
year according to the filter selected.   
 

  Show students with no result will only display those students 
who do not have a result entered for the selected competency.  Show All will show all the students 
enrolled in the competency for the year.  Any students with a result will have the result displayed in 
the Results column. 
 

To add results, click Edit , select the target students, select a result from the Outcome 
Assessment dropdown list and then click the Apply Changes button.    
 

 
 
This will add the selected result to all the selected students.  If any of the selected students already 
have a result entered, these students will have their existing result overwritten with the selected 
result.  The moderating teacher’s name may also be entered in the same way.  Click OK to save 
the changes and to acknowledge Bulk Results Update message.   
 

 
 

Note: The following fields may also be edited in Competency Enrolment Speed Edit: 

 Start and Completion Dates 

 RTO, Mode of Delivery and RTO Arrangement 

 Traineeship Type and Training Contract ID 

 Study Reason and 

 The VET in Schools flag. 
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Activity 

VET > Students 

 Click on VET Competency Enrolment Speed Edit  

 Click Find  

 Enter the following and click Find 
 

 
 

 Click Select and Yes 

 Click Edit  

 Highlight the first competency in the left-hand pane 

 Highlight most of the students in the right-hand pane 
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 Select a result of 20 Competency achieved and a Moderating Teacher 
 

 
 

 Click Apply  

 Click OK twice 
 

 

 Click Students with no result    

 Click Edit 

 Highlight the remaining students 

 Enter a Completion Date of 21 November 2014 
 

 
 

 Enter a result of 70 Continuing enrolment and a Moderating Teacher 

 Click   

 Click OK twice 
 

Caution: Year 12 students cannot be awarded an Outcome Assessment 
(Result) of 70 – Continuing Enrolment, as this will cause errors when 

reported to the Curriculum Council. 

 

 Enter results for all of the students enrolled in another unit of competency 
 

 

 Click on View Competency Enrolment by student   

 Find  Ashleigh Campbell 

 Enter results for all of her units of competency 

 Enter results for Frank Bishop 

 Close Competency Speed Edit 
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3.9.3 Qualification Achieved 

Activity 

VET > Students 

 Open Ashleigh Campbell VET Student Details 

 Click Edit  to the right of the Qualifications pane 

 Enter the Qualification Achieved details 
 

 
 

 Click OK 

Note: The Certificate Identifier is available from the RTO.   

 Repeat for Frank Bishop Certificate I in Keys to Employment  
 

 Close VET Student Details and VET Students 
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Recap: Student Profiling 

Complete each of the following tasks and note the pathway you took. 

1. Add the students in 2ACSC_3 to the VET Student list  
 
 
 
2. Create a VET Student Group: 2013 Info II.  Add the students enrolled in 2ACSC_3 to that 

group. 
 

 
 
 
 
 
 
3. Bulk-enrol the VET Student Group 2013 Info II in the Competency Group Cert II Info.  
 
 
 
 
 
4. Enter results for all students enrolled in one of the units of competency in the Competency 

Group Cert II Info. 
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5. Enter results for all competencies for one of the students in the Student Group 2013 Info II and 

show him or her as having achieved the Qualification. 
 
 
 
 
 
 

 
 
 

3.10 VET Reports 

VET > Reports 

The Integris VET module provides schools with a range of VET reporting options.  VET Reports 
are accessed via the Reports icon in the VET sidebar.  
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3.10.1 Types of VET Reports 

VET Reports are sorted by functional areas. 
 

School Curriculum 
and Standards 
Authority Reports 

These reports are designed to provide the School Curriculum and 
Standards Authority with data in a predetermined format. 

Note:  The above folder replaces the Curriculum Council Reporting folder in Transitional 
Reporting and should be used to produce all VET export files. 

Qualification 
Reporting 

Enables the school to view VET data by qualification.  Hardcopy outputs of 
each report can be produced 

Competency 
Reporting 

Enables the school to view VET data by unit of competency.  Hardcopy 
outputs of each report can be produced 

Student Reporting 
Enables the school to view VET data by student.  Hardcopy outputs of 
each report can be produced 

Employer Reporting 
Enables the school to view VET data by employer.  Hardcopy outputs of 
each report can be produced 

Standard Letters – 
Mail Merge 

Provides the school with the functionality to produce export files into MS 
Word 

RTO Reporting 
Provides the school with the functionality to view VET data for a given 
RTO, AVETMISS reporting is undertaken here 

RTO Certification Allows schools with active RTO status to print certificates 

VET Exports 
Provides the school with the functionality to export VET data for statistical 
analysis  

Submitting Authority 
Reporting 

Provides the RTO with the information about the authority submitting 
AVETMISS data  

Industry Area 
Reporting 

Allows the user to view School Offerings by Industry Area 
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3.10.2 Accessing VET Reports 

Accessing other VET reports is done through VET>Reports by clicking on the relevant folder 
holding a group of reports and clicking on the name of the required report. 
 

 
 
Where default Main Title and Footer fields appear in the report set-up window, the user can edit 
the title and/or footer. 

A number of reports make use of the Find tool in selecting settings.  
 
Some reports display the number of selections made.  
 

 
 

Click on the Select Date button to select the appropriate date from the school calendar.  
 

 

 The current day is shaded green 

 Use the single red arrows to scroll to different months 

 Use the double red arrows to scroll to different years 

 Use the Today’s Date button  to select the current day 

 Use the Reset date button  to reset the calendar to 
the previously selected date 

 Click on the date you wish to select and click OK 
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During training we will focus on and Standard Reporting – Mail Merge.  Reporting to the School 
Curriculum and Standards Authority will also be covered.  
 
 

3.10.3 Mail Merge 

Activity 

VET > Employers 

 
 

 Double click on Hungry Jacks 

 Click the Student Placements tab for Hungry Jacks 

 Close Employers 
 

VET > Reports>Standard Letters – Mail Merge 

 Highlight Students and Placements 

 Choose VET Students on the Current Roll from the Query drop down menu 

 Click on Select Folder  

 Highlight C:\keys\Integris\Outbox and click Select 

Note:  At school the pathway will be K:\keys\Integris\Outbox 

 Choose Parent Insurance Letter  as the Correspondence Type 

 Check the Record Correspondence box 

 Enter the dates: 1st January to 31st December  

 Check Surname, First Name, PG1 Salutation, PG1 Address 1, PG1Town/Suburb, PG1 
Postcode, Employer Name, Placement Start Date, Placement End Date and Placement 
Staff  

 Ensure Save Fields is checked 

Note:  Checking Save Fields ensures that the next time this Correspondence Type is 
selected the required fields are already checked. 
 
It is not possible to save fields for an unspecified Correspondence Type. 
 
Correspondence Types may be added in VET > Parameters. 
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 Click Print  

 Read the prompt and click OK 
 
It is now possible to merge the data exported from Integris with a mail merge template in Word. 
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 Open Word and the document C:\Keys\Integris\MMTPL\Letters\VET letters\mm\Parent 
Insurance Letter mm 

Note: VET mail merge templates are available from 
http://det.wa.edu.au/curriculumsupport/vetis  Navigate to Resources and Support. 

 Click Tools\Letters and Mailings\ Mail Merge  
 

 
 

 Click Next: Starting document 
 

 
 

 Click Next: Select recipients 
 

 
 

 Click Browse 
 

 
 

 Navigate to C\keys\Integris\Outbox 
 

 
 

 Double click on PARINS.csv 
 

http://det.wa.edu.au/curriculumsupport/vetis
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 Click OK 

 Click Next: Write your letter 
 

 
 

 Click Next: Preview your letters 
 

 
 

 Preview all your letters 
 

 
 

 Close the letters without saving 
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VET > Reports > Standard Letters – Mail Merge 

 Highlight Employers and Placement  

 Choose All Employers from the Query drop down menu 

 Click on Select Folder  

 Highlight C:\Keys\Integris\Outbox and click Select 

Note:  At school the pathway will be K:\keys\Integris\Outbox 

 Choose Employer Placement Insurance Letter as the Correspondence Type 

 Check the Record Correspondence box 

 Enter the dates: 1st January to 31st December  

 Check Employer Name, Employer Address 1 and 2, Employer Suburb, Employer 
Postcode, Employer Contact Title, Employer Contact Surname, Placement Staff, 
Surname and First Name  

 Check Save Fields 

Note:  Checking Save Fields ensures that the next time this Correspondence Type is 
selected the required fields are already checked. 
 
It is not possible to save fields for an unspecified Correspondence Type. 
 
Correspondence Types may be added in VET > Parameters. 

 
 

 Click Print and OK 
 
It is now possible to merge the data exported from Integris with a mail merge template in Word. 
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 Open the document C:\Keys\Integris\MMTPL\Letters\VET\mm\Employer Insurance Letter 
mm.doc  

Note: VET mail merge templates are available from 
http://det.wa.edu.au/curriculumsupport/vetis  Navigate to Resources and Support. 

 Click Tools\Letters and Mailings\Mail Merge  
 

 
 

 Click Next: Starting document 
 

 
 

 Click Next: Select recipients 
 

 
 

 Click Browse 
 

 
 

 Navigate to C\keys\Integris\Outbox 
 

 
 

 Double click on EMPINS.CSV 
 

http://det.wa.edu.au/curriculumsupport/vetis


 
Integris_VET_Advanced_Training_Notes.docx 13-Feb-13 

Page 104 of 130 

© 2013 Civica Education Pty Ltd 
 

 

 
 

 Click OK 

 Click Next: Write your letter 
 

 
 

 Click Next: Preview your letters 
 

 
 

 Preview all your letters 
 

 
 

 Close the letters without saving 
 

 

Note: These mail merge examples are based on Word 2003.  Users with other Word versions 
may find the process somewhat different to that used here. 
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3.11 Processing VET Students Active Status 

This process to update a students’ Active/Inactive status is required on an on-going basis, typically 
at the commencement of each calendar year.  This may be done through VET > Utilities. 
 

 
 

 Double click on Process VET Students Active status 
 

 
 

 Click Yes 
 
The system will go through every enrolling student’s record to determine if they have a current 
enrolment.  If they do, then a check will be made to ensure that their VET status is correctly 
marked as Active.  If they do not, then a check will be made to ensure that their VET status is 
correctly marked as Inactive.   
 

Important: 

This should be carried out only after the current year’s enrolments have 
been completed. 
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Activity 

VET > Students 

 View the number of VET students 
 

VET > Utilities 

 Double click Process VET Students Active status 
 

 
 

 Click Yes 

 Click OK 
 

VET > Students 

 View the updated list of VET students 
 

VET > Control > System Preferences 

 Check Display VET students with an Inactive status  
 

 
 

 Click OK 
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VET > Students 

 View the updated list of VET students 
 

 

4 Reporting to the School Curriculum and Standards 
Authority 

The WACE Procedures File provides information on how to upload files to the School 
Curriculum and Standards Authority after they have been generated by SIS.  The 
Procedures File is available at 
http://www.curriculum.wa.edu.au/internet/Publications/WACE_Procedures_File  

4.1 VET Enrolment 

Activity: 

VET > Reports > School Curriculum and Standards Authority Reporting > VET Enrolment 

 
 

 Print the reports to the screen 
 
Export files are also created.  At school these will be found in K:\KEYS\INTEGRIS\OutBox\.  There 
is an export file for each year level that has VET students.  These files may then be uploaded to 
the School Curriculum and Standards Authority. 
 

 Click OK 
 

 
  

http://www.curriculum.wa.edu.au/internet/Publications/WACE_Procedures_File
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4.2 VET UOC Results 

Activity 

VET > Reports > Curriculum and Standards Authority Reporting > VET UOC Results 

 
 

 Click Print 
 

 
 

 Click Yes 

Note:  As we have not entered results for all students an error log is displayed and no 
export file is created. 

 Close 

 Select 2012 and Print the report again 
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4.3 VET Qualification Achieved 

Activity 

VET > Reports > Curriculum and Standards Authority Reporting > VET Qualification 
Achieved 

 
 

 Print the reports to the screen 
 
Export files are also created. 
 

 Click OK 
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5 Ad Hoc Reports 

Admin > Reports > Ad Hoc Reports 

Users can create their own reports using the Ad Hoc section under the main reporting menu.   
 

 
 
Highlight the Ad Hoc Reports folder and click on Ad Hoc Manager that appears on the right-hand 
side of the window. The Ad Hoc Manager window opens. 
 

 
 

To create a new report, click Ad Hoc Wizard.  This will take you through the Ad-Hoc Wizard 
function, asking you to select what data you wish to include in your report and how you wish to sort 
it. Once you have progressed through all the Wizard windows you will be asked to create your 
report. This takes all the fields you have specified and displays them in the design window, 
enabling you to make changes to the layout of the report: 
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It is here that field lengths can be extended, text styles can be changed and fields can be 
rearranged, added or deleted to change the whole layout of the report. 
 
Closing the design window saves the set-up and brings you back to the Ad Hoc Manager window 
where all the reports created will be displayed. 
 

Use the  buttons to change the view of the ad hoc reports. 
 

 
 
Reports can be: 

 modified using the Modify Report icon  

 copied using the Copy Selected Report icon   

 renamed using the Rename Selected Report icon   

Note: It is a good idea to copy a report and give it a new name before making changes to 
the report. 
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Once reports have been defined they are run in the same way as standard reports.  

 Open the Ad Hoc Reports folder 

 Highlight the report to be printed 
 

 
 

 Use New Query to load the Student Search window and select students or load a saved query.  

 Print the report. 
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Activity  

Admin > Reports 

 Highlight the words Ad Hoc Reports 

 Click Ad Hoc Manager  
 

 
 

 Click Ad Hoc Wizard   

 Enter a Report Name and Description 
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 Click Next  

 Select the following fields: 
o Form 
o Medicare Number  
o Name: First Name 
o Name: Surname  
o Student No. 

 

 
 

 Click Next  

 Leave Selection Criteria – ALL 

 Click Next  

 Sort first by Form then by Surname 
 

 
 

 Check Total and Page for Form 

 Click Next  
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 Change the Print Order options as shown below using the blue chevrons 
 

 
 

 Click Next and Create  

 In the Ad Hoc Report Designer window, double click on the field heading Name: Surname 
and change it to Surname 

 

 
 

 Repeat for First Name  

 Make any other required changes  
 

 
 

 Close the Ad Hoc Report Designer window 

 Close the Ad Hoc Manager window 
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 Open the Ad Hoc Reports folder 

 Select VET Student Details 

 Use New Query to find the Active VET students  
  

 
 

 Print the report to the screen 

 Close the report  

 Close Admin Reports 
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6 School as an RTO 

Trainers: Include the following activities only when there are 
participants from schools who are RTOs. 

6.1 Register the School as an RTO 

It is imperative that only those schools that are Registered Training Organisations (RTOs) go 
through this process, because these registration details are used in School Curriculum and 
Standards Authority reporting. 
 
Schools that are Registered Training Organisations (RTOs) must identify their RTO details to the 
system.  This is done by selecting the Register as a Training Organisation option in the Delivery 
Planning menu.   
 

 
 

 Click on Register to open the window in edit mode   

 Enter the school’s registration details   

 Click OK  
 

6.1.1 Register School as RTO Toolbar 

 

 Edit: There can be only one RTO defined within the system. 
 

 Deregister: Deregisters the school as RTO. 
 

 Print: Prints the details for the training provider including location information. 

Note: RTOs that have student competency enrolments attached to them cannot be de-
registered; they can only be made inactive. 

To make an RTO inactive: 

 Click Edit  

 Uncheck Active  

 Click OK 
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Activity 

VET > Delivery Planning > Register School as Training Organisation 

 
 

 Double click on Register School as Training Organisation 

 Click on Register  

 Enter any missing details and click OK 
 

 
 

 Close 
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6.2 Enrolling/Resulting when the School is an RTO 

Activity  

VET > Students  

 Click Bulk Enrolments  

 On the Students tab, select  

 Hayden Cooper and Verity Gray and move  them from left to right 
 

 
 

 In the offerings pane, select the **Group** Cert I Info  and move  it from left to right 

 Click Add 
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 Enter the following Delivery details 
 

 
 

 Click Add 

 Enter a Study Reason and click Add 
 

 
 

 Close the Enrolment log 
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 Click Competency Speed Edit  and Students  

 Find  Hayden Cooper 
 

 Click Edit  

 Select Hayden Cooper and all his units of competency linked to the Cert I Info 

 Enter the Completion Date as YESTERDAY 

 Enter a Result of 20 and a Moderating Teacher  
 

 
 

 Click Apply and OK twice 
 

 Repeat for Verity Gray except give her a result of 30 for two units of competency 
 

 Close both Speed Edit windows  
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 Double click on Hayden Cooper 
 

 Select his Cert l Info and click Edit to the right of the Qualification pane 

 Enter the Completion Date as YESTERDAY 

 Check Qualification Achieved 
 

 

Note: the Certificate Information is greyed out. 

 Click OK 

 Close both VET Students windows 
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6.3 RTO Certification 

6.3.1 Qualification Certificate 

This report enables schools that are RTOs to print official certificates, records of achievement and 
an audit log of certificates printed.  Certificates can only be printed for students who have 
completed qualifications in the date range selected as well as an associated certificate ID. 
 
This is an official document printed on pre-printed stationery. 
 

Activity 

VET > Reports >RTO Certification > Qualification Certificate 

 Click  to extract qualification records 
 

 
 

 Click Print,  OK  

 

 Click  Yes 

Note: At school this would be printed on the approved pre-printed stationery.   

 



 
Integris_VET_Advanced_Training_Notes.docx 13-Feb-13 

Page 124 of 130 

© 2013 Civica Education Pty Ltd 
 

 

 View the Record of Achievement 
 

 
 

 Close the report 
 

 
 

 Click Yes 
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 Close the report 
 

 
 

 Click Yes 
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6.3.2 Statement of Attainment  

In the case where a student achieves fewer units of competency or modules required for a 
qualification, an RTO can issue a Statement of Attainment listing all the units of competency 
achieved for partial completion of a qualification.  Only competencies which have a result of 20, 50 
or 60 will be listed on the report.  
 
This is an official document printed on pre-printed stationery.    
 

Activity 

VET > RTO Reporting > RTO Certification > Statement of Attainment  

 From the Query drop-down menu select VET students on the Current Roll 

 Click  to extract qualification records 
 

 
 

 Click Print  
 



 
Integris_VET_Advanced_Training_Notes.docx 13-Feb-13 

Page 127 of 130 

© 2013 Civica Education Pty Ltd 
 

 

 

Note: At school this would be printed on the approved pre-printed stationery.   

 View the certificate then close 
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7 Support 
Should you require support please contact the Customer Service Centre (CSC) at the 
Department of Education. 
 
Contact details below: 

7.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 

7.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 

7.3 Email (CSC) 

customer.service.centre@det.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

8 Online Manuals and Training Notes 

8.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
http://www.civicaeducation.com.au/ 
 
Select Integris Support. 
Log in to Western Australian SIS Schools. 
Username: school 
Password: help 
 

8.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
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